## Table of Contents

### Announcements
- How do I create a Homeroom announcement as an instructor? ......................................................... 4
- How do I create a subject announcement as an instructor? ................................................................. 10

### Homeroom & Subjects
- How do I manage homeroom content and settings as an instructor? ............................................. 18
- How do I view my subject as an instructor? ......................................................................................... 20
- How do I manage subject content as an instructor? .......................................................................... 28
- How do I create a new subject from the Homeroom as an instructor? ............................................ 30

### Homeroom Navigation
- How do I use my Homeroom as an instructor? .................................................................................. 35

### People
- How do I sync enrollments and subject start and end dates from the homeroom as an instructor? 43

### Schedule
- How do I add an event to the schedule? ......................................................................................... 47
- How do I mark an assignment or calendar event with an important date as an instructor? .......... 51

### Settings
- How do I designate a subject as a homeroom course as an instructor? ........................................ 59
- How do I use subject settings? ........................................................................................................ 62
- How do I set details for a subject? .................................................................................................. 69
- How do I add an image to a subject card or banner? .................................................................... 79
- How do I view a subject as a test student using Student View? .................................................... 86
- How do I enable self-enrollment in my subject as an instructor? .................................................. 90

### Subject Navigation
- How do I manage Subject Navigation as an instructor? ................................................................. 96
- How do I customize the Subject Home Page as an instructor? ..................................................... 107
- How do I add Important Info in the Resources tab as an instructor? ........................................... 115
Announcements
How do I create a Homeroom announcement as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

Homeroom announcements display for all users in their Homeroom. A homeroom announcement displays for 2 weeks or until it is replaced by a new announcement. You can navigate past homeroom announcements using the Previous and Next buttons.

Notes:

- Your homeroom must be published for students to receive announcement notifications. If you import an announcement from another Canvas course, new announcement notifications will not send to course users.
- If an announcement is created before the homeroom start date and the Students can only participate in the course between these dates setting is enabled, students will not receive announcement notifications.

Open Homeroom

In Global Navigation, click the Home link.
Add Homeroom Announcement

If your Homeroom tab [1] is not currently displaying an announcement, you can add a new announcement by clicking the **Add Announcement** button [2].

**Note:** By default, the most recent announcement displays if it has been posted in the last two weeks. If you have an existing homeroom announcement, the Add Announcement button does not display. To replace the current announcement with a new announcement, click the **Homeroom subject** link [3].

Replace Homeroom Announcement

![Canvas for Elementary Instructor Guide Updated 2022-03-24](image)
If the Homeroom link was clicked, the Announcements page displays [1]. To add a new announcement to replace the current homeroom announcement, click the **Add Announcement** button [2].

**Create Announcement**

Type a title for the announcement in the **Topic Title** field [1] and add content in the Rich Content Editor [2].

**Select Sections**

By default, Canvas will send your announcement to all sections within your homeroom course. To select specific sections for your announcement, click the **Post to** drop-down menu and select sections from the list provided.
Note: If your course does not have sections, Canvas will still show the All Sections option, and all homeroom course users can view the announcement.

Add Attachment

To add an attachment to your discussion, click the **Choose File** button [1].

If required by your institution, you will need to select usage right settings for your attachment. To manage usage right settings, click the **Set usage rights** icon [2].

In the **Usage Right** drop-down menu [3], select one of five usage rights:

- I hold the copyright (original content created by you)
- I have obtained permission to use the file (authorized permission by the author)
- The material is in the public domain (explicitly assigned to public domain, cannot be copyrighted, or is no longer protected by copyright)
- The material is subject to an exception - e.g. fair use, the right to quote, or others under applicable copyright laws (excerpt or summary used for commentary, news reporting, research, or analysis in education)
- The material is licensed under [Creative Commons](https://creativecommons.org); this option also requires setting a specific Creative Commons license

If known, enter the copyright holder information in the **Copyright Holder** field [4].
To save your usage right settings, click the **Save** button [5]. You can edit usage right settings by clicking the Set usage rights icon.

**Select Options**

![Options panel](image)

In the **Options** section, you can schedule to post your announcement at a future date clicking the **Delay posting** checkbox [1].

Use the **Calendar** icon [2] to select a post date or type the date in the **Post At** field [3].

**Save Announcement**

![Save button](image)

Click the **Save** button.

**Note:** Unless you are using the delay posting option in Announcements, once you click Save, your announcement will immediately be posted in the Homeroom.
View Announcement in Homeroom

Welcome, Carla Gunderson!

Second Grade Homeroom
Show and Tell this Friday!
Remember to bring something from home for Show and Tell this Friday!

View the announcement in the Homeroom [1] including the announcement’s posting date and time [2].

By default, the Homeroom displays the most recent homeroom announcement for 2 weeks or until it is replaced by a new announcement.

To edit the announcement, click the Edit icon [3].

To navigate through homeroom announcements, use the Previous and Next buttons [4].

Note: If the Previous icon does not display, there are no previous homeroom announcements.

View Unpublished Homeroom Warning

Second Grade Homeroom
Your homeroom is currently unpublished.

Homework Due
Many of you have not turned in yesterday's homework. Please submit it by the end of the day.

Aug 27 at 10:05am

Your Homeroom must be published for students to receive announcement notifications. If your homeroom has not been published, a warning message displays in the Homeroom.
How do I create a subject announcement as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

Subject announcements display for all users in the subject’s Home page. An announcement icon also displays in the Homeroom’s subject card. A subject announcement displays for 2 weeks or until it is replaced by a new announcement. You can navigate past subject announcements using the Previous and Next buttons.

Notes:

- Your subject must be published for students to receive announcement notifications. If you import an announcement from another Canvas course, new announcement notifications will not send to course users.
- If an announcement is created before the subject start date and the Students can only participate in the course between these dates setting is enabled, students will not receive announcement notifications.

Open Subject

Click the Subjects link in Global Navigation [1]. Then select the subject name [2].
If the subject does not display on the Subjects list, you can view all of your subjects by clicking the **All Subjects** link [3].

**Add Subject Announcement**

If one or more subject announcements have been posted in the last 2 weeks, the most recent announcement displays on the Home tab [1].

If the Home tab is not currently displaying an announcement, you can add a new announcement by clicking the **Add Announcement** button [2].

To replace the current announcement with a new announcement, click the **Manage Subject** button [3].
Replace Subject Announcement

To replace the current subject announcement with a new announcement, click the Announcements link in Subject Navigation [1] and click the Add Announcement button [2].
Create Announcement

Type a title for the announcement in the **Topic Title** field [1] and add content in the Rich Content Editor [2].

Select Sections

By default, Canvas will send your announcement to all sections within your subject. To select specific sections for your announcement, click the **Post to** drop-down menu and select sections from the list provided.

**Note:** If your subject does not have sections, Canvas still displays the All Sections option, and all subject users can view the announcement.
Add Attachment

To add an attachment to your discussion, click the **Choose File** button [1].

If required by your institution, you will need to select usage right settings for your attachment. To manage usage right settings, click the **Set usage rights** icon [2].

In the **Usage Right** drop-down menu [3], select one of five usage rights:

- I hold the copyright (original content created by you)
- I have obtained permission to use the file (authorized permission by the author)
- The material is in the public domain (explicitly assigned to public domain, cannot be copyrighted, or is no longer protected by copyright)
- The material is subject to an exception - e.g. fair use, the right to quote, or others under applicable copyright laws (exempt or summary used for commentary, news reporting, research, or analysis in education)
- The material is licensed under **Creative Commons**; this option also requires setting a specific Creative Commons license

If known, enter the copyright holder information in the **Copyright Holder** field [4].

To save your usage right settings, click the **Save** button [5]. You can edit usage right settings by clicking the Set usage rights icon.
Select Options

In the Options section, you can choose to delay posting, enable podcast feed, and allow liking.

To schedule an announcement post date, click the **Delay posting** checkbox [1]. Use the **Calendar** icon [2] to select a post date or type the date in the **Post At** field [3].

To enable podcast feed, click the **Enable podcast feed** checkbox [4].

To allow announcement liking, click the **Allow liking** checkbox [5].

Save Announcement

Click the **Save** button.

**Note:** Unless you are using the delay posting option in Announcements, once you click Save, your announcement will immediately be posted in the subject.
View Subject Announcement

View the announcement in the subject’s Home [1] along with the announcement’s post date and time [2].

By default, the Home tab displays the most recent subject announcement for 2 weeks or until it is replaced by a new announcement.

To edit the announcement, click the Edit icon [3].

To navigate through subject announcements, use the Previous and Next buttons [4].

Note: If the Previous icon does not display, there are no previous subject announcements.
Homeroom & Subjects
How do I manage homeroom content and settings as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

You can manage homeroom content and settings via Homeroom Navigation.

For steps on managing content in a specific area of Canvas, view the Canvas Instructor Guide.

Open Homeroom

To open the Homeroom subject, click the Subjects link in Global Navigation [1]. Then click the Homeroom link [2].
Manage Homeroom Content

- Announcements
- Important Info
- People
- Files
- Settings

Use Home room Navigation to manage homeroom content and settings.

For steps on managing content in a specific area of Canvas, view the Canvas Instructor Guide.
How do I view my subject as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

You can use Subject Navigation tabs to view your Canvas for Elementary subject. You can also manage your subject and view the subject as a student.

Note: If you do not have an active enrollment in a Canvas for Elementary subject, the classic Course view displays.

Open Subject

In Global Navigation, click the Subjects link [1], then click the name of the course [2].
View Subject Settings

As an instructor, you can manage your subject or view the subject as a student from any subject tab.

To manage subject content or subject settings, click the Manage Subject button [1].

To view the subject as a test student, click the Student View button [2].
View Subject Home Page

In the Home tab [1], you may view, edit, or add subject announcements [2]. If one or more subject announcements have been posted in the last two weeks, the most recent announcement displays by default.

You can also view and manage your customized subject Home page [3].
View Subject Modules

In the Modules tab [1], you can manage modules and module items for your subject [2]. You can also set module prerequisites, add requirements, and publish or unpublish a module.

To view details for a module item, click the item's title [4].

Learn more about Modules.

Note: By default, the Modules tab does not display to students if the subject does not include modules.
View Subject Schedule

In the Schedule tab [1], you can view the Schedule Preview [2]. The Schedule Preview displays an example of how schedule items display to a student.

Each item displays the item name [3], number of points (if points have been assigned) [4], and the due date [5].

Each item also displays an icon to differentiate between different assignment types and other items in the Schedule [6].

Learn more about student schedules.
View Subject Grades

In the Grades tab [1], students can view their subject grades.

As an instructor, you can open the gradebook by clicking the View Gradebook button [2].
View Subject Resources

In the Resources tab [1], you can view important information you have added to your subject [2]. To edit Important Info, click the Edit icon [3].

Student applications that have been added to the subject display in the Student Applications section [4].

Notes:

- If the Important Info section does not display, content has not been added to the section.
- If the Student Applications section does not display, apps have not been added to the subject.
- If student applications and important information have not been added to the subject, the Resources tab does not display.
View Subject Groups

In the **Groups** tab [1], students can view subject groups.

As an instructor, you can manage groups by clicking the **Manage Groups** button [2].

**Note**: By default, the Groups tab does not display to students if the subject does not include any active groups.
How do I manage subject content as an instructor?

*This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.*

You can manage subject content via Subject Navigation.

For steps on managing content in a specific area of Canvas, view the [Canvas Instructor Guide](#).

---

**Open Subject**

To open your subject, click the **Subjects** link in Global Navigation [1]. Then click the subject link [2].

**Manage Subject**
Click the **Manage Subject** button.

**Manage Subject Content**

Use Subject Navigation to manage subject content and [subject settings](#).

For steps on managing content in a specific area of Canvas, view the [Canvas Instructor Guide](#).
How do I create a new subject from the Homeroom as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

If you have permission from your institution, you can create new subjects from your Homeroom. New subjects are created as course shells which can host course content and enrollments for your institution.

When you create a course from the Homeroom, you are automatically added to the course as an instructor. No other enrollments exist in the course, though you may be able to add users to a new course. Additionally, new courses do not contain course content. In the new course, you can create new content and add existing content using the course import tool and by sharing content from an existing course.

Alternatively, you can create a new course to use as a sandbox. A sandbox is a course without student enrollments where you can create, modify, and preview course content and structure without student interference. You can then share or import your sandbox content into live courses.

Notes:

- If you are not able to start a course as shown in these instructions, your institution has disabled this feature. Some institutions provide courses to faculty automatically via SIS (student information system) imports. For assistance creating a new course, contact your Canvas Admin.
- If your institution is using a course template, your new course will be populated with content from that template.
Start a New Subject

In the Homeroom, click the **Start a New Subject** icon.

**Note:** If you do not see this icon in Canvas, your institution has disabled this feature.
Create Subject

Type your course name in the Subject Name field [1].

To sync enrollments and subject start and end dates from your homeroom, click the Sync enrollments and course start/end dates from homeroom checkbox [2]. Then select the homeroom which you’d like to sync from using the Select a homeroom dropdown [3].

To create your subject, click the Create button [4].

Note: Concluded homeroom courses do not display in the Select a homeroom dropdown.
View the new subject. Depending on your institution's preference, you can use either the Course Setup Checklist or the Canvas Course Setup Tutorial to populate your course at any time.
How do I use my Homeroom as an instructor?

_This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface._

If your school is using the Canvas for Elementary feature, the Homeroom is the first thing you will see when you log into Canvas. The Homeroom helps you see what is happening in all your current subjects.

You can return to your Homeroom at any time by clicking the Home link in Global Navigation.

Open Homeroom

In Global Navigation, click the Home link.
View Homeroom

The Homeroom is your landing page in Canvas.

In the Homeroom tab [1], you can view your published [2] and unpublished course subjects [3].

To open a course subject, click the name of the subject [4].

To add a new subject, click the Start a New Subject icon [5].

To create a homeroom announcement, click the Add Announcement button [6].

In the sidebar, you can view assignments, graded discussions, quizzes, and calendar events that have been marked with an important date [7].

Note: By default, your published and unpublished subjects display in the Homeroom tab. However, if you have favorited subjects, only favorited subjects display.
In the **Schedule** tab [1], you can view an example of how schedule items will display for students.

Each item displays the subject name [2], item name [3], number of points (if points have been assigned) [4], and the due date [5].

Each item also displays an icon to differentiate between different assignment types and other items in the Schedule [6].

When an online assignment is submitted, the item is automatically marked as completed. Students can manually mark non-submission items as complete by clicking the item's checkbox [7].
In the Grades tab [1], you can open the gradebook for a specific subject by clicking the subject’s View Gradebook button [2].
In the Resources tab [1], you may view important information you have added to your homeroom [2]. To edit existing important information, click the Edit icon [3].

You can view any student applications that have been added to your homeroom in the Student Applications section [4].

You can also view staff contact information [5].

Notes:
- If content has not been added to Important Information, the Important Information section does not display.
- If student applications have not been added to the homeroom, the Student Applications section does not display.
View Homeroom To Do

In the To Do tab [1], you can view all items that require grading in Canvas. Items display by due date in ascending order.

Each item indicates how many items need to be graded [2], the assignment name [3], the course name [4], the number of points [5], and the due date for the assignment [6]. Some assignments may display multiple due dates.

To remove a To Do item, click the Remove icon [7].

Note: When an item is removed, the item can only be restored to the To Do tab if a new submission is received for that assignment.

Switch to Classic View

To switch to the classic Canvas dashboard, click the Options icon [1] and select the Classic View option [2].
Return to Homeroom View

To return to the homeroom dashboard, click the **Options** icon [1] and select the **Homeroom View** option [2].
People
How do I sync enrollments and subject start and end dates from the homeroom as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

You can sync enrollments and subject start and end dates from the homeroom. If you have access to multiple homerooms, you can choose which homeroom you’d like to sync from.

Note: If any subject enrollments were added via SIS import, the Sync enrollments and course start/end dates from homeroom checkbox does not display.

Open Subject

In Global Navigation, click the Subjects link [1]. Then select the subject link in which you’d like to sync enrollments [2]. If the subject does not display on the Subjects list, you can view all of your subjects by clicking the All Subjects link [3].
Manage Subject

Click the **Manage Subject** button.

Open Subject Settings

The subject’s **Settings** page displays [1].

Click the **Course Details** tab [2].
Sync from Homeroom

To sync enrollments and subject start and end dates from your homeroom, click the **Sync enrollments and course start/end dates from homeroom** checkbox [1].

Select the homeroom in which you’d like to sync from using the **Enrollments** drop-down menu [2]. If your subject has been synced previously, the last sync date displays [3].

**Note:** If your subject added enrollments via SIS import, the Sync enrollments and course start/end dates from homeroom checkbox does not display.

**Update Course Details**

To begin syncing enrollments from the homeroom, click the **Update Course Details** button.
Schedule
How do I add an event to the schedule?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

A Canvas event is a non-graded Canvas activity. Events created on the Calendar appear in the Homeroom and subject Schedule tabs and student calendars. You can create events with due date times as well as all-day events. You can also duplicate an event.

You can include Zoom, Microsoft Teams, WebEx, or Google Meet conferencing links in the event description or location. If a conferencing link is added to the event description or location, students can join the meeting from the Homeroom Schedule tab or subject's Schedule tab.

Open Calendar

In Global Navigation, click the Calendar link.
Add Event

Click any date on the calendar to add an event [1]. Or, click the arrows next to the month name to navigate to a different month [2] and select a date.

If you do not want to manually locate the date, you can click the Add icon [3].
Add Event Details

Enter a title for the event [1].

Depending on how you added your event, the date may be populated for you. If not, enter a date in the date field [2] or select a date from the calendar by clicking the Calendar icon [3].

The calendar times may also be populated for you in the From fields [4]. Edit or enter the start and end time for your event. To create an all-day event, leave the From fields blank so there is no start and end time for your event.

To add a physical event location or conferencing link, use the Location field [5].

In the Calendar drop-down menu [6], select the subject calendar for the event. Events added to your personal Calendar or the Homeroom Calendar do not display for students in the Schedule tab.

To mark the event as an important date, click the Mark as Important Date checkbox [7].

You can add more details to your event, such as an event description, address or duplicate the event by clicking the More Options button [8].

Note: If a Zoom, Microsoft Teams, WebEx, or Google Meet conferencing link is added to the event description or location, students can join the meeting from the Homeroom Schedule tab or subject's Schedule tab.
Submit Event

To save your event, click the Submit button.
How do I mark an assignment or calendar event with an important date as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

As an instructor, you can mark assignments, graded discussions, quizzes, and calendar events with an important date. Important date items display in the Homeroom sidebar.

Notes:
• User calendar events do not support important dates.
• Differentiated assignments marked with an important date display the due date assigned to the student in the Homeroom sidebar.

Open Assignment, Graded Discussion, or Quiz

From the subject’s Modules tab [1], click the title of the assignment, graded discussion, or quiz you’d like to mark with an important date [2].
Edit Item

Click the Edit button.

Add Important Date

Add a due date [1].

To mark the due date as an important date and display the item in the Homeroom sidebar, click the Mark as important date and show on homeroom sidebar checkbox [2].

To save your changes, click the Save button [3].

Notes:
• Important dates can only be marked for assignments, graded discussions, quizzes, and calendar events.
• A due date must be added to mark an assignment, graded discussion, or quiz with an important date.
• Differentiated assignments marked with an important date display the due date assigned to the student in the Homeroom sidebar.

Open Calendar

You can mark a calendar event with an important date.

To open the Calendar, click the Calendar icon in Global Navigation [1].

In the Calendar sidebar, select the Canvas for Elementary course calendar in which you’d like to mark an event with an important date [2].

Note: User calendar events do not support important dates.
Open Calendar Item

To mark an existing calendar event, assignment, or graded discussion with an important date, click the calendar item [1] and click the Edit button [2].

Alternatively, you can add a new event by clicking the Create New Event button [3].
Manage Calendar Event

To mark the event date as an important date and show the event in the Homeroom sidebar, click the **Mark as Important Date** checkbox [1].

To save your changes, click the **Submit** button [2].
Manage Assignment or Graded Discussion

To mark an assignment or graded discussion as an important date and show the event in the Homeroom sidebar, click the **Mark as Important Date** checkbox [1].

To save your changes, click the **Submit** button [2].
View Important Date Items

Important date items display in date order in the Homeroom sidebar.

Note: The Homeroom sidebar displays up to 100 items.
Settings
How do I designate a subject as a homeroom course as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

It is recommended that every teacher have a dedicated homeroom. Once a subject is designated as the homeroom course, functionality is limited to items needed to manage content on the dashboard.

Open Subject

In Global Navigation, click the Subjects link [1]. Then select the name of the subject you'd like to designate as the homeroom course [2].

If the subject does not display on the Subjects list, you can view all of your subjects by clicking the All Subjects link [3].

If you do not have a subject that you'd like to designate as the homeroom course, you can create a subject from the homeroom.
Manage Subject

Click the Manage Subject button.

Open Settings

Collaborations
SCORM
Chat
Canva for Education

In Subject Navigation, click the Settings link.
Enable Setting

To designate the subject as the homeroom course, click the **Enable as homeroom course** checkbox.

**Note:** If the Enable as homeroom course checkbox does not display in Subject Settings, the Canvas for Elementary feature has not been enabled for your institution.
How do I use subject settings?

*This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.*

In subject settings, you can update settings, view users and sections, and modify the subject navigation. Depending on your permissions, you can edit differing levels of subject settings.

Manage Subject

From the subject, click the **Manage Subject** button.
View Subject Details

The Settings page displays [1].

In the Course Details tab [2], you can view subject details including card and banner images, the subject name, quota, and the license you've attached to the your subject's content.

You can also view the course status [3]. If the subject cannot be unpublished, the hover text will notify you accordingly.

**Note:** If you do not have permission to publish a subject, or if the subject is published and includes grades, you cannot modify the course status.
View Sections

In the Sections tab, you can add a section to your subject and manage student section enrollments.
View Navigation

In the Navigation tab, you can modify Subject Navigation links. You can drag and drop to reorder and hide subject navigation links.

Any configured subject navigation External Apps (LTI Tools) that appear in Subject Navigation also appear here.
View Apps

Apps are an easy way to add new features to Canvas. They can be added to individual courses, or to all courses in an account. Once configured, you can link to them through course modules and create assignments for assessment tools.

See some LTI tools that work great with Canvas.

If your institution has enabled the Canvas App Center, in the Apps tab you can view all available external learning tools in Canvas. However, you can also configure apps manually.
**View Feature Options**

![Feature Options Tab](image)

<table>
<thead>
<tr>
<th>Feature</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessibility Checker Notifications</td>
<td>✓</td>
</tr>
<tr>
<td>Allow Outcome Extra Credit</td>
<td>✗</td>
</tr>
<tr>
<td>Anonymous Grading</td>
<td>✗</td>
</tr>
</tbody>
</table>

In the **Feature Options** tab, you can enable and disable Canvas features within your subject as made available by your account admin.
View Integrations

<table>
<thead>
<tr>
<th>Feature</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Sync</td>
<td>✓</td>
</tr>
</tbody>
</table>

Sync and Provision Microsoft Teams with your Canvas Course
Note: Syncing is triggered by changes to course enrollments. The first time you enable Microsoft Sync, you may have to trigger a sync manually with the button below.

Status: Ready for sync | Last Sync: never | No errors

If enabled by your institution, you may also view the Integrations tab. From the Integrations tab, you can sync enrollment data to Microsoft Teams.
How do I set details for a subject?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

As an instructor, you can manage the details in a Canvas for Elementary subject. The Course Settings page may allow you to manage subject identification details, the subject’s card and banner images, subject color, Blueprint information (if any), file storage data, subject grading scheme, license, visibility, subject format, and other options available for the subject.

Manage Subject

In the subject, click the Manage Subject button.
Open Subject Details

The **Settings** page displays [1]. Click the **Course Details** tab [2].
View Subject Details

The first section of Course Details shows you an overview of your subject.

If you have permission to publish a subject, you can manage your course status in the sidebar [1].


The Color section displays the selected subject color [4]. A custom subject color can be added using the Color field [5].

If allowed by your institution, you can edit the subject name [6] and course code [7].

You can manage the subject’s friendly name using the Friendly Name field [8]. The friendly name displays as the subject name in notifications and in the dashboard.

You can view the subjects blueprint course status [9] and course template status [10], the subject’s time zone [11], and in which subaccount the subject is in [12].

To sync enrollments and start and end dates from your homeroom, click the Sync enrollments and course start/end dates from homeroom checkbox [13]. If any subject enrollments were added via SIS import, the Sync enrollments and course start/end dates from homeroom checkbox does not display.
Notes:

- If you do not have permission to publish a subject, or if the subject is published and includes grades, you cannot modify the course status.
- When managing a subject, an instructor can view the subject name at the top of the page. If the subject has a friendly name, the friendly name displays.

View Subject Images

If your institution allows you to add an image to a subject's card in the Homeroom or a banner image to the subject's Home tab, you can add or replace the card image or wide banner image.

Notes:

- Wide banner images are cropped to a 5:1 aspect ratio.
- If a banner image is not set, the home page uses the card image. If a card image has not been set, the banner displays the course color.
View Subject Color

The subject color is persistent across all subject related subject dates and items throughout Canvas.

You can add a custom subject color using the Color field.

**Note:** If a subject color is not set, the subject color defaults to gray.

View Blueprint Course

Your Course Details tab indicates whether the subject has been enabled as a blueprint course and displays Yes or No [1].

If your subject is associated with a blueprint course, the blueprint course name and course ID displays [2]. If you have been enrolled in the blueprint course as an instructor or TA, the name of the blueprint course will contain a link to access the blueprint course.

Most commonly, your subject will be associated with a blueprint course and you can only manage unlocked content in your subject. If your subject is a blueprint course, you can lock and sync subject content to associated subjects.
View Subject Dates

Subjects may be assigned to the Default Term or a specific term [1]. By default, your students will be able to participate in the subject within the term dates [2].

If needed, you can allow students to participate within course dates [3] and set specific subject start and end dates [4]. However, changing subject dates may override term availability settings and placement in the Homeroom. Please confirm term dates before adding subject participation dates.

You may also be able to change student access settings to allow or restrict students from viewing your subject before the start or end date [5].

Note: If a subject participation end date is set to midnight, a warning message displays [6].

View Subject Language

You can set a specific language for your subject. By default the language is set to Not set, English (US). Selecting a language for your subject will override user language preferences and is only recommended for subjects conducted in the selected language.
View File Storage

**File Storage:** 800 megabytes

You can view the storage file size allowed in your subject. File storage consists of all files in subject files and assignment submissions. Administrators at your institution set the file storage quota for each subject.

**Notes:**

- Canvas course imports count against subject quotas. If a course import fails, verify the size of the file against your file storage quota. If necessary, contact your Canvas admin to request a larger subject quota.
- Copied Canvas subjects and subject items do not count against subject file storage quotas. You can copy existing Canvas subjects and subject items from the original subject into your new subject without impacting your subject file storage quota.

View Large Course Setting

**Large Course:**

- [ ] Launch SpeedGrader Filtered by Student Group

You can enable the option to launch SpeedGrader filtered by student group in your subject. When this setting is enabled, you must choose a student group when opening SpeedGrader. This setting is disabled by default.

View Grading Scheme

**Grading Scheme:**

- [ ] Enable course grading scheme

You can enable a grading scheme for your subject. A grading scheme is a set of criteria that measures varying levels of achievement in a subject. You can also view the current existing grading scheme, if any. This setting is disabled by default.
View License

You can view the license for your subject. By default all content is considered private and copyrighted, but you can also release your content to the public domain or choose a Creative Commons license. When making your course public, you will most likely want to set a license for your subject.

View File Usage Rights

You can view the file copyright setting for your subject. If this option is enabled, usage right information must be selected for all subject files before they can be published. This setting is disabled by default.

Note: If the option to manage file usage rights cannot be changed, your institution has locked this setting.

View Visibility

You can view any visibility settings for your subject. Each visibility option is independent of the others. You can customize subject visibility, customize content visibility, and include the subject in the public course index.
View Formats

You can set the format for your subject using the Format drop-down menu [1].

You can also enable the subject as a homeroom course using the Enable as homeroom course setting [2].

View Description

If your subject is part of the public course index, you can include a description for your subject in the description field.
View More Options

You can change more options in your course by clicking the More Options link [1].

You can grant additional course privileges for students by selecting the appropriate checkbox or drop-down menu [2]:

- Allow students to attach files to discussion replies by clicking the Let students attach files to Discussions checkbox. Enabled by default.
- Allow students to edit or delete their own discussion posts by clicking the Let students edit or delete their own discussion posts checkbox. Enabled by default.
- Hide student grade totals in the grades page by clicking the Hide totals in student grades summary checkbox. Disabled by default.
How do I add an image to a subject card or banner?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

If your institution allows, you can upload an image to display within the course card in the Homeroom and a subject banner image on the subject’s home page.

Accepted image types include JPG, JPEG, GIF, and PNG files. Subject card and banner images can also be added from Unsplash. All images from Unsplash are licensed under the Unsplash License.

When uploading a subject card image, it's recommended to use images approximately 262 pixels wide by 146 pixels high. Banner images are cropped to a 5:1 aspect ratio. It's recommended to use images at least 100 pixels high.

Note: If a banner image is not set, the home page uses the card image. If a card image has not been set, the banner displays the course color.

Manage Subject

From the subject, click the Manage Subject button.
Open Subject Details

The Settings page displays [1]. Click the Course Details tab [2].
Choose Image

To add a card image, click the Card Image **Choose Image** button [1].

To add a banner image, click the Wide Banner Image **Choose Image** button [2].
Upload File

To upload your own image, drag and drop your image into the **Upload Image** section. Or, to browse your computer and locate an image, click the **Upload Image** section [2].

Subject card images are recommended to be approximately 262 pixels wide by 146 pixels high. When uploaded, subject card images are centered and cut to the recommended width.

Banner images are cropped to a 5:1 aspect ratio when added. It's recommended to use images at least 100 pixels high.
Search Unsplash

To use an image from Unsplash, click the Unsplash tab [1]. Enter a search term in the Search field [2]. Search results display all related images and may include more than one page.

To use an image, click the image [3].

Note: Canvas uses safe search filters provided by Unsplash. You can read more about the Unsplash content policy on their Terms page.
View Image

Any image added to the card image or banner image displays.

Manage Image

To manage an image, click the image's Options icon [1]. To change the image and select a new one, click the Choose image option [2]. To remove the image completely, click the Remove image option [3].
Update Course Details

To save your changes, click the **Update Course Details** button.
How do I view a subject as a test student using Student View?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

You can view a subject the same way that your students do through Student View. Enabling Student View creates a Test Student in your course. You can also activate Student View in your subject Settings.

Use Student View to view the course, post and reply to discussions, submit assignments, view grades, pages, quizzes, the schedule, and resources.

You can reset Test Student data at any time; however, Test Student activity that involves interactions with other students cannot be removed, such as discussion replies. Test Student data that involves interactions with other students are retained even if the test student is removed from enrollments.

Attendance, Conferences, Collaborations, differentiated assignments, external apps, groups, Inbox peer reviews, and profiles do not work for the Test Student. You will see only what you, as the instructor, allow your students to see.

Notes:

- Each Canvas subject has a separate Test Student account. Whenever you move to a new subject you will need to enable Student View for that subject.
- Submissions and scores for the Test Student do not affect course analytics.
- You can only view the subject layout as it is seen by your students. You cannot view student-specific information, such as conversations between students.
- Student View should not be used to test MasteryPaths in the beta or test environment.
- Once you activate Student View, the Test Student is shown at the end of the Gradebook and SpeedGrader and is automatically added to every section in your course. If you want to remove the test student completely, you must remove the test student from your section enrollments.
- New Quizzes assessments should be previewed in New Quizzes and not taken as the test student. Test Student attempts cannot be reset and will affect analysis reports.
Open Student View

To view a subject as a test student, click the Student View button.
View Subject

You can now view the subject as a student user would see it.

You will know if you are in Student View because of the persistent box on the bottom of the screen indicating you are logged into Student View.

Reset Student

You can also reset the Test Student by clicking Reset Student. This action will clear all activity that does not include any student interaction.

For example, if you created an assignment and submitted it as the Test Student but forgot to add a certain submission type, you can click the Reset Student button and submit the assignment again as the Test Student.
Leave Student View

You are currently logged into Student View. Resetting the test student will clear all history for this student, allowing you to view the course as a brand new student.

To return to your subject in the instructor view, click the Leave Student View button.
How do I enable self-enrollment in my subject as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

If your Canvas admin has enabled self-enrollment for your institution and the subject is publicly visible, you can enable self-enrollment in your subject. Self-enrollment allows a student to enroll in a subject using a secret URL.

Note: If you cannot view the options for self-enrollment, your institution has disabled self-enrollment.

Open Subject

In Global Navigation, click the Subjects link [1]. Then click the subject name [2].

To view a list of all of your subjects, click the All Subjects link [3].
Manage Subject

Click the Manage Subject button.
Open Subject Settings

The subject Settings page displays [1]. Click the Course Details tab [2].

View More Options
At the bottom of the page, click the **More Options** link.

**Enable Self-Enrollment**

- **Let students self-enroll by sharing with them a secret URL**
- Let students attach files to discussions
- Let students edit or delete their own discussion posts
- Let students organize their own groups
- Hide totals in student grades summary

Select **Only Teachers**

*can create, rename, and edit course pages by default*

To allow students to self-enroll in your course using a secret URL, click the **Let student self-enroll by sharing with them a secret URL** checkbox.

**Allow Self-Enrollment on Subject Home Page**

- **Add a "Join this Course" link to the course home page**
- Let students attach files to discussions
- Let students edit or delete their own discussion posts
- Let students organize their own groups
- Hide totals in student grades summary

Select **Only Teachers**

*can create, rename, and edit course pages by default*
To allow students to enroll in your subject from the subject's Home page, click the **Add a "Join this Course" link to the course home page** checkbox.

**Update Subject Details**

Click the **Update Course Details** button.

**View Self-Enrollment URL**

```
Description:

This course has enabled open enrollment. Students can self-enroll in the course once you share with them this URL:

https://docilamas.beta.instructure.com/enroll/TTM4GM

more options
```

Copy and share the provided secret URL.
Subject Navigation
How do I manage Subject Navigation as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

As an instructor, you can control which tabs appear in Subject Navigation. Canvas includes a set of default tabs that are shown by default and cannot be renamed. However, you can choose to reorder or disable subject tabs. Depending on your course configuration, other tabs may be available and customizable.

Links to tabs that don’t have any content and that students cannot create content for will be automatically hidden for students and will display the Visibility icon to instructors in Course Navigation. Configured External Apps may create additional subject tabs.

Notes:

- The Groups tab displays for instructors by default. However, students can only view the Groups tab if the subject includes at least one active group.
- If the Grades tab is disabled in a subject, grades for that subject do not display in the homeroom Grades tab. If the Grades tab is disabled for all subjects, the Grades tab does not display in the homeroom.
- A subject’s Resources tab is automatically hidden when external apps have not been added to the subject and content has not been added to Important Info.
- If you disable an external tool from Subject Navigation, the LTI button no longer displays in the subject’s Resources tab.
Open Subject

In Global Navigation, click the **Subjects** link [1]. Then select the name of the course you'd like to manage [2].

If the subject does not display on the Subjects list, you can view all of your courses by clicking the **All Subjects** link [3].

Manage Subject

Click the **Manage Subject** button.
Open Settings

View the Subject Navigation Menu [1]. To learn more about using the subject links, view the Canvas Instructor Guide.

To manage the menu, click the Settings link [2].

Open Navigation

Click the Navigation tab.
Drag and Drop Navigation Links

You can use the drag and drop option to reorder items in Subject Navigation. Click the subject tab you would like to move. Drop it in the desired location by releasing the mouse.
Move Navigation Links

You can also use the Move To option to reorder items in Subject Navigation. To move a subject tab, click the Options icon [1] and select the Move link [2].

Note: The Move To option only moves a subject tab within its respective section (visible or hidden). Hidden items must first be enabled before they can be ordered among visible navigation items. A hidden item cannot be moved directly to the enabled link section using the Move To option.
Place Navigation Link Location

In the Move Navigation Item sidebar, click the **Place** drop-down menu [1]. Select the placement of the navigation item you are moving [2]. You can move the item so it is located at the top of the list, before a specific navigation link, after a specific navigation item, or at the bottom of the list.
Place Before or After

If you selected the **Before** or **After** option, click the second drop-down menu [1]. Select the navigation item that should be before or after the tab you are moving, as indicated by the option selected in the previous menu [2].

If you want to move the navigation item to another location, change the sidebar placement options as needed.
Move Navigation Item

Click the Move button.
Hide Navigation Links

Drag and drop items to reorder them in the subject navigation.
If enabled, LTI tools will always appear last under the Resources tab in the order you choose.

To hide a subject tab, click the item's Options icon [1] and select Disable [2].

You can also drag and drop the link to the hidden section at the bottom of the page.
Enable Navigation Links

To enable an item in the hidden section [1], click the **Options** icon [2] and click the **Enable** option [3].

You can also drag and drop the link above the hidden section.

Save Navigation

Click the **Save** button.
View Subject Navigation tabs. Subject tabs display in the same order you have designated in Settings [1].

Notes:

- Hidden navigation items will not display tabs in the subject. As an instructor, you can access hidden navigation items in Subject Navigation by clicking the Manage Subject button [2].
- If you have disabled a tab for an external tool, that tab will not display and is hidden to all course users, including instructors in Subject Navigation.
How do I customize the Subject Home Page as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

In Canvas for Elementary, each subject may include a Home tab. Along with subject announcements, the Home tab displays content designated as the Subject Home Page on the subject’s Pages Index Page.

The Subject Home Page allows instructors to display subject-specific content and can include links, images, or rich media. Students can interact with content added to the Subject Home Page.

If a subject home page is not been assigned or has been removed, students can only view announcements in the subject’s Home tab.

Note: Only published pages can be set as the Subject Home Page.

Open Subject

In Global Navigation, click the Subjects link [1]. Then click the subject link [2].

If the subject does not display on the Subjects list, you can view all of your courses by clicking the All Subjects link [3].
Manage Home Page

Manage Home Page

History Quiz this Friday!

Remember to study for the history quiz this Friday!

This is where you'll land when your home is complete.

Manage Home

To create a Subject Home Page, click the Manage Home button.
Edit Current Home Page

Favorite Book Friday
Bring your favorite book to class on Friday.

Orientation: Language Arts & Reading
In this class, you will learn:
- Reading comprehension
- Phonics
- Grammar
- Poetry
- Vocabulary
- Spelling
- Processing skills
- Elements of writing

Reminder:
Each week there will be a spelling quiz.

To edit a current Subject Home Page, click the Edit icon.
Manage Current Home Page

The current Subject Home Page displays [1]. You can edit page content and settings.

To select a different page or create a new page to use as the Subject Home Page, click the Pages link in Course Navigation [2].
View All Pages

Orientation: Language Arts & Reading

To-Do Date: Apr 9 at 11:59pm

Orientation: Language Arts & Reading

In this class, you will learn:

- Reading comprehension
- Phonics
- Grammar
- Poetry
- Vocabulary
- Spelling
- Processing skills
- Elements of writing

Reminder:

Each week there will be a spelling quiz.

By default, your current Subject Home Page displays.

To select a different page or create a new page to use as the Subject Home Page, click the View All Pages button.
Set Subject Home Page

The Pages Index Page displays all of your subject pages [1]. To create a new page, click the Add Page button [2].

To set a page as the Subject Home Page, click the page's Option icon [3], then click the Use as Subject Home option [4].

Only one page can be set as the Subject Home Page. The page that was most recently set as the Subject Home Page retains the subject home page assignment.

Note: Only a published page can be set as the Subject Home Page.
Remove Subject Home Page

To unassign a page as the Subject Home Page, click the page's Options icon [1] and select the Remove as Subject Home option [2].
View Subject Home Page

Welcome to 2nd Grade Language Arts with Ms. Gunderson! I'm so excited to meet all of you. If you have any questions or concerns, let me know.

Instructor: Ms. Gunderson
Email: carla.gunderson.canvas@gmail.com

Subject Modules
Complete the modules in order. You may access modules from this page or by clicking the Modules tab.

- Module 1: Sentence Structure
- Module 2: Reading
- Module 3: Creative Writing

View the assigned subject home page content in the subject's Home tab.
How do I add Important Info in the Resources tab as an instructor?

This lesson applies to users at institutions that have enabled the Canvas for Elementary user interface.

You can add Important Info to the Homeroom’s Resources tab or a subject’s Resources tab. Added information will only display in the Homeroom or subject in which it was added.

Note: If content is not added to Important Info, the Important Info section does not display on the Resources tab.

Open Subject

Click the **Subjects** link in Global Navigation [1].

To add information to the Homeroom, click the Homeroom link [2].

To add information to a subject, click the subject link [3].

If the subject does not display on the Subjects list, you can view all of your courses by clicking the **All Subjects** link [4].
Manage Subject

To add Important Information to a subject, click the Manage Subject button.

Note: This is not required when adding important information to the Homeroom.

Open Important Info

Click the Important Info link in Subject Navigation.

Add Important Info

You can add important information here that you want to display under the Resources tab.

If you have not added content to Important Info, a message displays [1].
To add content to Important Info, click the **Edit** button [2].

**Add Important Info**

Use the Rich Content Editor to add content to Important Info.

**Save Content**

To save, click the **Update Important Info** button.
View Important Info

The Resources tab of the subject or homeroom in which information was added [1] displays Important Info with your added content [2].

To edit content, click the Edit icon [3].